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Description
What the
GUI Will
Do

The Agilent AC Source Graphical User Interface (GUI) is an easy
to use soft front panel for the Agilent Technologies 6800-series
AC Power Source/Analyzers. With it, you can:
ñ Control output and measurement functions from a single
screen.
ñ View an oscilloscope-like display of actual output
waveforms.
ñ View the harmonic content of the output waveform.
ñ Easily generate complex output transients and user-defined
waveforms by clicking and dragging the mouse.
ñ View the instrument commands generated by the graphical
user interface.
ñ Operate in either simulation mode (no ac source hardware
required), or in instrument control mode.

What the
GUI Will
Not Do

The Graphical User Interface does not:
ñ Automatically generate test programs
ñ Control instruments other than Agilent ac sources
ñ Provide drivers for other GPIB instruments
ñ Link with the Agilent HFTS software
ñ Operate with Windows 3.1

System Requirements
PC

ñ 486DX66 minimum (Pentium 100 or better recommended)
ñ 16 Mbytes RAM
ñ 4 Mbytes of disk space

32-bit
Platforms

ñ Windows 95 - 98
ñ Windows NT 4.0

Supported
I/O

ñ Agilent 82340B, 82341C, 82341D, 82335B1
ñ National AT GPIB/TNT, AT GPIB/TNT PnP (Windows 95)
ñ RS-232
1

The Agilent 82335B is only supported for Windows 95, provided you have
either the E2094F or E2094E I/O library.

Supported
Ac Source
Models

ñ Agilent 6811A/B, 6812A/B, 6813A/B, 6814B, 6834B
ñ Agilent 6841A, 6842A, 6843A (in Normal mode only)
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Installing and Running the Software
NOTE: Before running the Agilent AC Source GUI, you must have installed
and connected your ac source to the pc using the appropriate interface
cable. If you are using a National Instruments GPIB interface, you
must have the appropriate card installed and configured on your pc. If
you are using an Agilent GPIB interface card, you must also have the
appropriate 32-bit SICL library drivers installed on your pc.
1.
2.

3.

Place Disk #1 in the A: drive of your computer and run SETUP.EXE.
Follow the directions on the screen to install the software. The
README.TXT file contains product updates or corrections that are not
documented in the help file. Use any text editor to open and read this file.
To run the Agilent AC Source GUI, click on its desktop icon:
You can also click on the Start button and select:
Programs | Agilent AC Source | AC Source GUI.

Configuring the I/O
To configure the I/O, select the I/O Configuration command in the Edit menu.
This step is necessary to establish communication with the ac source. The I/O
configuration screen comes up automatically when you turn Simulation mode off
in the Source menu. Note that operating the ac source over a serial port is much
slower than GPIB operation.
RS-232 only.
Specifies the com
port on the pc.

Select I/O type.
(GPIB, serial port, or
simulation mode)

RS-232 only. Ac source
must match Baud rate
and Parity settings.

Address must match
setting of
instrument. (GPIB

National cards only.
Specifies board
index. (1 = GPIB1)

Agilent GPIB cards
only. Must match
SICL name used in
interface card’s
configuration.

Automatically searches
all interfaces for ac
sources.

If there seems to be no communication between the Agilent AC Source GUI and
the ac source, select Auto Detect to detect any ac sources connected to your pc.
Also try resetting the I/O interface by clicking the red reset button. This also
resets the ac source to its default settings.
NOTE:

If you program the ac source from the front panel of the unit, you will
need to refresh or update the Agilent AC Source GUI. Go to the
Source menu and select the Refresh Instrument State command.
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Performing Basic Operations
The Main window appears when you first run the Agilent AC Source GUI. From
this window you can control the output of the ac source as well as view all output
measurements.
Click to start
a
t

Click to configure
measurements.
Turn on the ac
source output.

Click Enter to
apply all values
to the output.

Waveform
display area.

Set the output
to 120Vac. Use
/ keys or
keyboard entry.

pq
Measurement
summary

Select an
output

To access an existing configuration,
ñ

Click File, Open Configuration in the menu. Configuration files contain
Agilent AC Source GUI settings but not actual ac source instrument settings.

ñ

Select the desired file (files have an *.set extension) and click Open.

ñ

To create a new configuration, click File, New Configuration. This action
clears the present configuration, resets the ac source instrument to its default
values, and sets the I/O to simulation mode.

To program the output of the ac source,
ñ

Under Output Control, program the output rms voltage, dc offset voltage,
frequency, rms current limit, and peak current limit. You can either type in
the values directly, or use the up/down arrows to adjust the present value. If
you type in the values, you mst press the Enter button.

ñ

For 3-phase ac sources, select the Phase that you want to control. You can
couple or control All phases simultaneously, or control each phase
individually.

ñ

Select a waveshape from the Waveshape list box - either Sinewave,
Squarewave, or Clipped sinewave. For clipped sinewaves, you can specify
the clipping level in percent of amplitude, or in percent of total harmonic
distortion.

5

ñ

Select Output On to enable the output of the unit. Select Output Off to
turn the output off. Note that the selected waveshape will not appear on the
Main window unless you click the Measure button.

To view output measurements,
ñ

Select the Config Measurements command in the Measure menu. Select
the Configure Waveform Display folder.

Specify type of
measurement.

Select units for
harmonic graph axes

Only applies to
units with the AUX
channel option.

ñ

To view voltage or current measurements, select Voltage, Current, or
Voltage + Current in the Waveform to Display dropdown list.

ñ

To view harmonic measurements, select a harmonic display functions.

ñ

Click the Measure button to make an output measurement. The following
figure shows a sample voltage harmonics measurement. Note that for 3phase ac sources, you can only measure one phase at a time. Only the
measurement of the selected phase is returned.

Click

Displays the
specified
harmonics.

To save the configuration settings,
ñ

Click File, Save Config in the menu.

ñ

Enter a filename (setup files have an .set extension) and click Save.
Note that Output Control settings are NOT saved in the setup file.
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Printing and Saving Measurement Data
To print the measurement screen, click on either the Print icon or select the
Print command in the File menu. You can preview and print the Main window
only. The following is a sample preview/print of the Main window:
Click

To save the waveform that appears in the display, select Save Waveform in the
File menu. This saves the displayed waveform as an ASCII file, which can be
easily imported into other application programs.
To log measurement or waveform data to an ASCII text file, select the Config
Measurements command in the Measure menu. Select the Configure
Measurements folder. Check the appropriate Log to file box and provide a name
for the data file. Data will be logged whenever an output measurement is made.

Check to enable
measurement or
waveform data logging.
Specify a
measurement data
filename (file
extension = *.mlg).
Specify a
waveform data
filename (file
extension = *.wlg).

The measurement data file saves measurements in a comma-separated table of
values. The columns in the list correspond to all available measurements, with
blanks for non-measured values. For 3-phase units, only information from the
selected phase will be saved.
The waveform data file saves measurements in a 3-column format. The columns
are Time, Voltage and Current. Harmonics are not saved.
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Sample Tests
Several sample tests are provided with the Agilent AC Source Graphical User
Interface. These pre-defined tests help you quickly perform some common ac
source applications.
Inrush Current Measurement
To perform an inrush current measurement, select Inrush Current in the Tests
menu. The test uses the parameters that you enter in the following dialog box.
This box is displayed on the screen when the test is first selected.
Click here to continue.
This displays the
Output Transient
Editor. (see below)

Enter a Final
Line Voltage
value
Enter a turn-on
phase angle.

Output goes to
120 Vac @ 90°
phase angle.
(Drag point to
adjust amplitude.)

Start of output
measurement
Output voltage
starts at 0 Vac.

Check to enable
measurement
trigger.

Click to start
sample test.

You can use the transient editor to make any final adjustments to the inrush
current measurment such as fine tuning the width of the transient step, or
positioning and enabling the measurement trigger.
When measurements are enabled, you can view the inrush measurement in the
Main window. If necessary, move the Transient editor out of the way to see the
Main window. The following figure shows a sample inrush curent measurement.
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View the
inrush
current.

AC Line Dropout
To perform an ac line dropout, select Dropout in the Tests menu. The test uses
the parameters that you enter in the following dialog box. This box is displayed
on the screen when the test is first selected.
Click here to continue.
This displays the
Output Transient
Editor.

Enter the number of
dropout cycles
Enter the dropout
voltage value

Check to enable
measurement
trigger.

Enter a starting
phase angle.

Step #3, output
voltage returns to
120 Vac.
(Drag point to adjust
amplitude .)

Start of output
measurement

Step #1,
output voltage
@ 120 Vac.

Drag pointer to
adjust width of
dropout.

Step #2, output
voltage @ 0 Vac
for one cycle.

Check to enable
measurement
trigger.

Click to start
sample test.
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You can use the transient editor to make any final adjustments to the ac line
dropout test such as fine tuning the width of the dropout, or positioning and
enabling the measurement trigger.
When measurements are enabled, you can view the line dropout measurement in
the Main window. If necessary, move the Transient editor out of the way to see
the Main window.
AC Line Surge or Sag
To perform an ac line surge/sag, select Surge/Sag in the Tests menu. The test
uses the parameters that you enter in the following dialog box. This box is
displayed on the screen when the test is first selected.
Click here to continue.
This displays the
Output Transient
Editor. (see below)

Enter a Surge/Sag
Voltage value

Enter T1 value.
Also enter T2 and
T3 values in the
appropriate fields.

Start of output
measurement

Output voltage
returns to 120 Vac
at step #3.

Output voltage
set to 120 Vac
at step #1.
Output voltage
surges to 170
Vac at step #2.

Check to enable
measurement
trigger.

Click to start
sample test.

You can use the transient editor to make any final adjustments to the ac line
surge/sag test such as fine tuning the slew rates of the surge or sag, or
positioning and enabling the measurement trigger.
When measurement are enabled, you can view the line surge/sag measurement in
the Main window. If necessary, move the Transient editor out of the way to see
the Main window.
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Telephone Ring Generator
CAUTION: This test is only designed to test telephone ringer circuits. Do not
use this test to power any device that requires ac input power.
The telephone ring generator produces an output signal to test telephone ringers.
The test uses the parameters that appear in the dialog box that is displayed on the
screen when the test is first selected.
Click here to continue.
This displays the
Output Transient
Editor. (see below)

Enter the ring
amplitude in rms
volts
Enter the dc level
of the waveform

Enter a ringer
frequency.

Enter a ringer ontime value.
Enter a ringer offtime value.

DC offset set to
80 V (Drag
point to adjust
amplitude.)
Ringer offtime level.

Start of step #2.
(Drag pointer to
adjust width of
step.)

Repeat the
number of
rings.

Click to start
sample test.

You can use the transient editor to make any final adjustments to the telephone
ringer waveform such as fine tuning the dc level of the waveform. Note that the
transient editor only displays the rms-portion of the telephone ringer; it does not
display the actual waveform.
When measurements are enabled, you can view the ringer waveform in the Main
window. If necessary, move the Transient editor out of the way to see the Main
window.
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Editing With the Transient List Table
The previous four sample tests introduced you to using the click and drag editing
features of the Transient Editor.
A more precise method of creating and editing transients is available by using
the Transient List table. Click the View Table button in the Output Transient
editor. The Transient List table is simply another view of the transient editor.
The values in the table correspond exactly to the corresponding transient graph.
The following table shows the values for the sample Surge/Sag test.
Click
Menu commands
to simplify editing.
Select and edit
individual values
in each cell.

Creating User-Defined Output Waveforms
To create user-defined voltage waveforms, select either the waveform icon or
the Arbitrary Waveforms command in the Source menu. This window lets you
edit basic waveform shapes to create a user-defined arbitrary waveform.
Waveforms can be edited in either waveform or harmonic format. To create or
edit a waveform, the Display Mode must match the Edit Mode. Download the
completed waveform to the ac source. To output the downloaded waveform,
you must select it in the Waveshape box of the Main window.
Download the
waveform to the ac
source.

Click

Drag
waveform
points to edit
the shape.

Select New or
Open to edit a
waveform
Save the waveform
as an ASCII file.

Edit Mode must
match Display
Mode to edit the
waveform.

Select to zoom the
display in or out.
Indicates the
of the active point.
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To create or edit waveforms in the harmonic format, set the Edit Mode and the
Display Mode to Harmonics. Note that continually switching edit modes will
result in cumulative waveform truncation errors. Therefore, select only one edit
mode to work in. Switching display modes does not cause recalculation errors.
Drag harmonic
to change the
amplitude.

Edit Mode must
match Display
Mode to edit the
waveform.

Lets you edit
individual
waveform
data points.

Generating AM or FM Output Signals
AM or FM ouput signals can be precisely generated using the AM amd FM
Modulation table. Either click the Modulation icon, or select the Modulation
command in the Source menu.
AM or FM output waveforms consist of a carrier signal (the fundamental) and a
modulation signal. The voltage and frequency of the carrier signal is defined in
the Output Control section of the Main window. Only the modulation signal is
defined in this dialog box.
Lets you edit
# of steps in
modulation
profile.

Click

Enter
parameters for
modulation
signal.

Modulation signals are comprised of from one to 20 individually programmed
steps that may be combined into a modulation sequence and then run. Each step
programs the modulation signal for the duration of the step. The amplitude and
frequency of the modulation signal may be constant, swept linearly, or swept
logarithmically from the starting value to a stop value. The sweep period is
programmed in seconds.
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Advanced Controls
To access the less frequently used output controls, select the Output Control
command in the Source menu. These output controls include slew rate settings,
relative-phase on 3-phase units, output coupling, voltage range, and save/recall
states.
Specify output
voltage, frequency, or
dc offset slew rates.

Save or Recall
instrument states in
non-volatile memory

Resets the ac
source to its poweron state.
Select AC+DC to
dc-couple the
output.

To program Output impedance, select the Impedance command in the Source
menu.You can program real or reactive impedance. These controls are not
available on all ac source models.
Enable ouput
impedance control

Enter impedance
values

To configure output measurements, select the Config Measurements command
in the Measure menu. Then select the Configure Measurements folder. You can
select what measurements appear in the measurement summary area and how
often the summary measurements are updated. You can also configure
measurement and waveform logging, as previously discussed.
Check which
summary
measurements to
display on the Main
window.

Specifies the time
between measurements.
Applies to waveforms and
summary measurements.
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To program minimum and maximum user-defined limits for critical ac source
parameters, select the User Defined Limits command in the Source menu. The
controls in this dialog box can be used to prevent a user from accidentally
programming dangerous voltage or frequency values in the Main window.
Enter minimum and
maximum userdefined limit values.

Resets the limits to
the hardware default
values.

To display the maximum programmable values for the ac source that is presently
being controlled by the Agilent AC Source GUI, select the Ratings command in
the Source menu.
Displays maximum
programmable
settings of ac source.

To view the SCPI instrument commands sent to the ac source, select
Instrument Commands in the View menu.
Select command
viewing options.
View the
programming
commands.
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Warranty
This Agilent Technologies software product is warranted against defects in materials and
workmanship for a period of 90 days from date of delivery. During the warranty period,
Agilent Technologies will, at its option either repair or replace parts which prove to be
defective.
Agilent Technologies makes no express or implied warranty of any kind, including, but
not limited to the implied warranties of merchantability or fitness for a particular
purpose, with regard to the program material contained herein. Agilent Technologies
shall not be liable for incidental or consequential damages in connection with or arising
out of the furnishing, performance, or use of this software.
Use of the supplied manual and software is restricted to Agilent Technologies ac source
products only. The software is copyrighted and may not be copied except for archival
purposes, to replace a defective copy, or for program error verification. Agilent
Technologies warrants that this software designed for use with a personal computer, will
execute its programming instructions when properly installed on that personal computer.
Agilent Technologies does not warrant that the operation of the personal computer ,
software, or ac source will be uninterrupted or error free.

Limitation of Warranty
The foregoing warranty shall not apply to defects resulting from: misuse, unauthorized
modification, operation or storage outside the environmental specifications for the
product, in-transit damage, improper maintenance, or defects resulting from use of nonAgilent Technologies software, accessories, media, or such items not designed for use
with the product.

Notice
This document contains proprietary information protected by copyright. All rights are
reserved. No part of this document may be photocopied, reproduced, or translated into
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contained in this document is subject to change without notice.
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